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First Power up & Verification

Now that we’ve assembled our printer, our first goal before proceed further is to validate that the printer functions. To do so, connect the power supply to the printer. You should see a row of blocks on the LCD display of the printer, as well as see the Hot-End cooling fan, and electronics cooling fans working. There should be no smoke, flames, or other effects at this time. Congratulations!


Firmware Configuration

a. Installing & configuring the  Arduino IDE

Before we begin configuring the firmware, we must first install the appropriate software and drivers to interact with our printer. To begin, we must first install the Arduino IDE. Please visit: http://www.arduino.cc/en/Main/Software and select the latest IDE for your platform. [image: image1.png]Buy Download Products ~ ng ~ Forum  Support v Blog IN  SIGN UP
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Once you have downloaded the appropriate IDE, run the installer and follow the commands on screen. This installation will also include the driver needed to connect to your printer in later steps. 

Once you have installed the Arduino software, you may now connect your printer to the power supply, and connect the USB Type B cable from your computer to the printer. 

We must now configure the Arduino software to communicate with our printer, to do so, launch the Arduino IDE. From the Tools Menu, select the Board option, and then the ‘Arduino Mega 2560 or Mega ADK’. The Mega 2560 is the core of our printers electronics, and is commonly used in the RAMPS 1.4 configuration. 
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From the Tools menu again, select the Serial Port. In this drop down you will see several options. The option that we wish to use should begin with ‘/dev/tty.usbmodem…’. This should be the location of our printer. It is important that you do not have any other Arduino powered devices connected to your PC at this time. 
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Congratulations, you’ve installed the Arduino IDE and configured it to talk to your printer. In the next step we will begin modifying the firmware and writing it to our printer. 

b. Downloading & configuring the Marlin Firmware

Now that we have the Arduino software configured and connected to our printer, we must obtain the Firmware and make the necessary changes to it in order to suite our printer. The firmware is the ‘brains’ of the printer, which allows it to interpret gcode, commands, and control motors, extruders and all kinds of accessories. For our purposes we will be using one of the most popular firmwares, MarlinFirmware.

Visit https://github.com/MarlinFirmware/Marlin. On the right hand side of the window, choose the ‘Download ZIP’ button to download the latest release of the Marlin Firmware.  
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Once the download has completed, extract the Zip folder to a safe location on your computer. 

There will be several sub directories and documents contained within the download. For our purposes, we are concerned with the files and configurations located at:  Marlin-Release\Marlin-Release\Marlin. 
With the Arduino IDE open, select the File > Open option, and then navigate to the directory listed above. In this directory, locate the ‘Marlin.ino’ file, and click ‘Open’.
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With the Firmware project files loaded, your IDE should look like this: 
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In the tabs at the top of the window, locate the tab ‘Configuration.h’. This is where we will make all the necessary changes required for our firmware. 

The first configuration we must modify is the defined motherboard. In our case, this is located on line 47 of the configuration file. 

Note: The line number is located in the lower left hand corner of the Arduino IDE. 

Change the defined motherboard from #define MOTHERBOARD BOARD_ULTIMAKER to #defineMOTHERBOARD 33. 33 denotes the stock RAMPS 1.4 setup used in our printer. 

The second option we must modify is located on line 107. This is the thermistor used in the hot-end. For our purposes, if using an e3D Lite6, this value should be changed from -1 to 5. Set the values of line 108-110 to 0. Your Thermistor table should look like so: 
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We must now configure our maximum extruder temperatures. Because we are using an e3D Lite6, our maximum temperatures cannot exceed 250. Change this value on line 132 like so:
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Our next configuration is defining the end-stops. Our printer uses end-stops at the minimum positions, and none at the maximum, so we must remove the maximum end-stop configuration from the firmware. In these cases 2 forward slashes like so // will comment out any line of code and render it un-usable to the Arduino. You will need to comment out lines 284, 285, and 286 like so: 
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We must also set the end-stop inverting to false. Change the true value to false for lines 293-298 like so: 
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Our most important configuration of the firmware is defining the size of the printer’s volume. Defining an area larger than what the printer can physically print is a bad idea, and can cause serious issues, so we must set these values to be equal to or slightly less than the actual physical volume of the printer. The fields that need to be changed are located on lines 337, 339 and 341. In our case, these values should be changed to 140 like so:
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We must now configure our Homing Feedrate. For the purposes of our printer, these should be set to the following values on line 478: 
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After we have defined our feed rate, we must set our default steps per millimeter. These values indicate how many motor steps are required to travel 1mm. A good baseline for our printers is provided below. Modify these values in your configuration on line 482: 
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It’s also good to modify our max feed rates to the following on line 483:
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And lastly, set our default max acceleration to the following values on lines 484, 486 and 487
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We’ve now completed the most crucial parts of the configuration, but we still have a few options remaining. 
You will also want to define the EEPROM settings for the configuration, namely enabling them. To do so, uncomment (remove the 2 ‘//’) from lines 519 and 522 like so:
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Lastly, we must enable support for the LCD panel on our printer. To do so, uncomment the line 552. This will enable support for the LCD panel included with your printer. 

[image: image17.png]// The RepRapDiscount Smart Controller (white PCE)
// http://reprap. orq/viki/RepRapbiscount Smart Controller

// The GADGETSSD G3D LCD/SD Controller [blue BCEH)
// Bttp://reprap. orq/uiki/RAMPS 1.3/1.4 GADGETSSD Shield with Panel
//#define G3D_PANEL





Click File > Save when you are finished. 

Congratulations! Your firmware is now complete and ready to be verified. To verify and compile your firmware, click the check icon in the upper left corner of the window. If all goes correctly, in a few moments you should receive a message at the bottom of the screen indicating that the firmware has been compiled like so:
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With the firmware compiled, and your printer connected to your PC, you may begin the process of uploading the firmware. To do so, after compiling the firmware, click the arrow button next to the Compile button. The message in the bottom of the window will change to ‘Uploading Firmware’ and you will see a progress bar appear. When the firmware is flashed correctly, you will see ‘Upload finished’ appear in the bottom of the window, and you should see your printer information appear on the LCD panel of your printer. Congratulations!



Printer Control Using Cura


a. Installing and configuring Cura

Now that we have compiled and uploaded the firmware for our printer, we must turn our attention to the software we will use for manipulating the models and creating profiles that allow us to print objects. These is commonly known as a slicer, and there are many options available on the market today. In keeping with our open-source nature, we are using Cura, developed by the amazing team at Ultimaker. 
In order to begin, please visit: https://software.ultimaker.com/ and download the latest stable release of Cura for your platform.

[image: image19.png]Software downloads

These are official releases of the Cura software for use with your Ultimaker.
Cura is Open Sousce Software and sources can be found at github.

Below you can download the latest release for your operating system (Windows. MacOS X or Linux)

2C

Download Cura_15.02.1 for WinNT

See below for other versions.





Once downloaded, launch the installer and follow the prompts on screen to install Cura. At the end of the installation Cura will automatically launch, and the first run wizard will appear. Click Next to continue. 
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On the next screen you will be asked to select the type of printer that you intend to use. For our purposes, choose the last option, Other, and click Next. 
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The following screen presents a number of different printer configurations for us to choose from. We will choose the final option, Custom. Click Next to Continue. 
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We will now need to enter some basic information about our printer. For our printer, these settings are as follows. Click Finish when you ready. 
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With the basic configuration complete, we will spend a few minutes tweaking our slicing profile to suite our first print. 

The primary interface of Cura is broken into 2 components. To the right we have the virtual build volume. This where your models are placed. The box on screen represents the build volume of your printer. The second component is the slicing parameters. These are the user controllable options that adjust variables such as the layer height, print speed and support material. 
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For the purpose of our first prints, lets adjust some of these settings. 

First and foremost, we will adjust the layer height from the stock 0.1 to 0.3. The lower this number, the thinner the layers will be. This will produce a better print, but can also be more challenging and time consuming. 0.3 layer heights are a good compromise between ease of use and quality. 
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The second option that we must modify is the Filament diameter. This value should be changed to 1.75mm, the diameter of the filament that our printer uses. 
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To initially test our printer, we will need to load the advanced UI and Pronterface UI for Cura. To do so, from the File Menu in Cura, choose Preferences. In the Preferences window, change the Printing Window Type to Pronterface UI like below:
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For the time being, the rest of the default values will work for our first prints. We will also cover these options in depth later in this guide. 

You can also learn more about Cura through Ultimaker’s official documentation at: https://ultimaker.com/en/support/view/248-cura-manual
b. Connecting your printer to Cura

Connecting your printer to Cura couldn’t be easier. Simply connect the USB cable from your PC to the printer, ensure that your printer is powered up, and launch Cura. You should see the middle icon in Cura’s 3d stage labeled ‘Print with USB’. 

c. Understanding the print controller

For the following guide, we will first need to load a temporary model into the stage of Cura in order to display the printer controller. We will however not be printing at this moment. 
To load a model, click the folder icon on the stage, and select your model. For illustration purposes, we are using a extruder base from the mapleMaker Mini printer. 
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You should now see the object placed in the centre of the stage. When ready, click the Print with USB button. You should now see the Pronterface Interface:

[image: image29.png]i

250 Temperature

b:: o ]

ﬁd“ Bed temp

0 I
=

B





The Pronterface interface is broken into 4 main areas. The first area is the motion controllers for the printer itself. The large cirular dial allows you to control individual axis’ of the printer in 0.1, 1, 10 and 100mm increments. 
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The vertical sliders to the right of the axis controller allows the user to raise or lower the Z axis, as well as extrude filament through the extruder. Note: Do not extrude or retract filament unless the hot end is up to temperature. Doing so will damage your printer. 
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The third area is the temperature control and information. The graph will display the active temperature of the hot end, while the adjoining fields will allow the user to modify the temperature of the extruder. 
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The last area is the gcode window. This window will display various gcode information such as gcode for your sliced models, as well as error messages and other information. At the bottom of the window is a single line field which will allow the operator to send commands to the printer. We will be using this for our first test runs. 
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d. Validating your printer capabilities

iii. Axis movements

The most important step in our initial configuration is to ensure that the axis’ of the printer move, and move in the correct direction. 
The axis of the printer is set up in the following: 
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The extruder travels in the X axis, as well as up and down in the Z axis, while the print bed travels only in the Y axis. 

The starting point for the printer, the co-ordinates of 0,0,0 is towards the front right corner of the printer. This means that if we move any one axis in a positive direction, we are moving away from this point, and if we are moving in a negative direction, we are moving towards this location. 

This is illustrated in the diagram below. For instance, the maximum travel of the X axis, 140mm would have the extruder all the way to the left side of the print bed, while extending the Y axis to its maximum travel of 200mm would bring it forward. 
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To test our axis’, ensure that each of the axis’ are near the middle of their travel and connect your printer to your PC and follow the previous steps to load a temporary model and open the Pronterface UI in Cura. 

We will test one axis at a time for the following procedure. 

To test the X axis, using the Pronterface controller, click on the second inner ring of the right side button (labeled +X). The X axis should move away from our starting point of 0,0,0. Repeat this step in the opposite direction for the X axis. The axis should move back towards our starting point. 
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Repeat this step for the Y and Z axis as well. Both axis’ should move in the correct direction. If for whatever reason they move opposite of the intended direction, disconnect your printer, and unplug the power to the printer. Remove the electronics enclosure cover, and locate the motor driver for the affected axis. Simply unplug the motor cable and reverse itse direction. This will reverse the direction of the motor. Reconnect your power supply and conenct the printer to your PC. Repeat the steps above and validate that the axis’ move in their proper direction. 
iv. End stop validation
With the correct movement of the axis’ verified, we must now verify that our end-stops function as they should. 

To do so, ensure that none of the axis’ are touching the end-stops. From the Pronterface interface, type M119 into the Gcode window and press entered. If all goes well, you should see the Gcode window dispay several lines of text. These should read as:
X_min: open

Y_min: open

Z_min: open

Now, using your free hand, depress the X axis end-stop and while depressed, repeat the previous step. Your response should be:

X_min: TRIGGERED

Y_min: open

Z_min: open

Repeat this procedure for the Y and Z axis. All 3 axis should behave similarly. If any of the end stops behaves differently, disconnect your printer, and verify that the end stop connections on both the end stop and on the RAMPS board are correct. Repeat the procedure to ensure the end stops are working correctly. 



Final Printer Configuration

The steps below will help you fine tune the performance of your printer and prepare it for the first print. 

a. Setting your end stops 

Setting your end-stop distance is a simple yet important step. To complete this step you will need your M3 hex wrench. 
To set the X axis end-stop, slide the carriage to the minimum extent. The X end stop should be depressed by the screw on the extruder assembly. If it is not, use your hex wrench to extend the screw onto the tab of the end stop. You should hear an audible click when the end-stop is depressed. Do not extend the screw any further than this. 
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The procedure is much the same for the Y axis as well. Extend the Y axis to the minimum of its travel and check to see if the screw on the bottom of the Y axis is contacting the end-stop. If it is not, use your hex wrench to extend the screw until it does. Again, listen for the audible click of the screw depressing the end-stop. 
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Adjusting your Z end-stop will be covered in the next chapter. 

b. Leveling your print bed

Leveling your print bed is perhaps the most crucial step we must take before we print our first object. Thankfully it’s a straight forward procedure and one that can be completed easily. You should also periodically re-level your print bed. 
You will need the following:

· Blue painters tape

· A business card or semi-thick sheet of paper

· M3 hex wrench

Before we begin, we must first prepare our print surface. Printing with PLA can be one of the easiest filaments to work with, as well as delivering some of the best results. PLA is also unique in that it does not need a heated bed to print on, and can be printed on a very easy to apply bed, 3M Blue Painters Tape.

Use Blue Painters Tape to cover the print bed completely. Blue Painters tape can usually be found at most hardware stores, in widths ranging from 1 to 2 inches. 
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It is important that when applying the strips of painters tape, to not overlap the tape. Overlapping the tape will produce a small ridge in your print surface which can affect your print quality and results. It’s best to butt each strip up against each other, or leave a very small gap between each strip like so:
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With a layer of painters tape applied to the bed, we can now begin to level our print bed. 

First we must set the initial height of the Z axis. To do so, we will connect the printer to our PC and launch Cura and the Pronterface interface as illustrated earlier. 

Move the X axis to its minimum position, along with the Y axis. Using the pronterface interface, you can click on the small Home icons in each of the X and Y controllers to home each axis to its minimum positon. 

With the X and Y positon at their minimum, begin to lower the Z axis. As you get closer to the print bed, lower your Z axis 1mm at a time.

As the extruder tip reaches the print bed, grab your business card, or semi-thick piece of paper. Slide the paper between the print bed and the extruder. Like so:
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Continue to lower the Z axis, this time in 0.1mm increments. 
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Lower the extruder until you can feel a slight tug when moving the paper between the bed and extruder. We don’t want the print head to be crushed into the paper, just slightly snagging it. The thickness of the thick paper represents an ideal first layer height. 

With the initial layer height set, using your M3 hex wrench, extend the Z Axis screw until it contacts the Z end stop. Listen carefully for the audible click of the end-stop, and stop extending the screw when you hear it. You’ve now set your initial layer height. 
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We’ve now set one corner of our print bed as the reference point for the rest of the bed. 

In order to level the remainder of bed, move the extruder to the extent of the X axis (the far left corner) 
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Using the method before, slide the card between the bed and the extruder. Using your hex wrench, either tighten or loosen the screw in that corner to raise or lower the print bed until the paper drags between the bed and extruder. 
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Continue this procedure for the left rear and right rear corner of the print bed as well. Using your hex wrench and card to set the height of the print bed. 
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If all goes well, all four corners of your bed should have the same set distance between the print surface and tip of the extruder. Keep in mind that the print surface should not be level with the surface the printer is sitting on, but be level with the extruder tip at any point of its travel. 
Congrats, you’re one step closer to your first print!

c. Loading Filament

Note: Your printer is compatible with 1.75mm diameter materials, and works best with PLA filament. 

Before we print our first object, we must load filament into the extruder. To do so, mount a roll of filament onto the filament spool holder and find the end of the filament on the spool. Using a pair of scissors, remove the last few millimeters of filament to ensure that there is a clean cut edge entering the extruder. 
Using your fingers, gently straighten out several inches of filament as best as you can. The filament will have a tendency to curl, and straightening the filament will make it easier to insert into the extruder. 

Connect your printer to your PC, and using Cura pre-heat the extruder to 190 degrees. Do not proceed with the next step until your extruder has reached this temperature. 

With the filament prepared, pull back on the idler on the extruder like so:
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While pulling back on the idler, insert the filament between the drive gear and idler bearing and into the hot-end like so: 
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You should be able to feel the resistance when the filament enters the hot end. Let go of the idler and check to ensure that the idler bearing is making contact with the filament. 
d. Extruding Filament

Now that we have pre-heated our extruder and loaded the filament, we will now prime the extruder and check to see that it is extruding filament correctly. 
Open the Pronterface UI from Cura if it is not already open, and check to ensure that the extruder is at its operating temperature of 190 degrees. 

From the control panel, locate the extruder panel. This is marked with two arrows labeled ‘E’ for extruder. Click on the ‘+10’ button to begin extruding. This will extrude 10mm of filament. 
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You should now see the extruder drawing in the filament. If the extruder is retracting the filament, stop the procedure and disconnect your printer. Open the electronics enclosure and reverse the connection of the extruder motor. Repeat the process above to verify that the motor is operating in the correct direction.  

Keep extruding 10mm of filament. It will take several attempts before you see any material extruding from the extruder. 

It is also important to ensure that the idler is applying adequate pressure to the filament and drive gear. If while extruding you notice the filament slipping or the drive gear not grabbing the filament, tighten the 2 screws on the idler assembly. This will increase the pressure against the extruder drive gear.  

You should now begin to see filament extruding from the extruder. Ensure that the filament is extruding in a thin strand and is not building up around the tip of the nozzle. With your extruder primed and ready, we’re almost ready to begin your first print. 

Note on calibrating your extruder.

In some cases it may be necessary to calibrate your extruder and the amount of filament it extrudes per millimeter. For an excellent introduction to this procedure and a video guide, please visit Thomas Sanladerer’s YouTube video here: https://www.youtube.com/watch?v=YUPfBJz3I6Y
Your default firmware values should provide a decent calibration and good printing results. 

e. Understanding the Printer LCD & SD Card Reader
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Your printer is equipped with a LCD display, as well as a built in SD Card Reader. This allows your printer to print untethered without the need for a PC. Printing from an SD card will be covered later in this document. The LCD displays a variety of information during a print. The primary fields are the following: 
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The first line displays the real time temperature reading of the hot-end, and the desired set temperature.
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The second line contains positional data of each of the axis’. 
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The last line of the display contains the flow rate. The flow rate is the amount of plastic the printer is extruding. Typically this is set in firmware or slicing profiles. The final two options report back the total percentage of the model that the printer has printed, as well as the elapsed time. 
The LCD panel is also equipped with a rotary dial. Pressing this dial will activate the Menu tree and give host to a wide variety of options to control and modify your printer. This menu system is broken into several sections with multiple sub sections:

These menus and the additional SD card slot allow your printer to print without an computer attached. 

Top Level:

Watch: This will return you to the main overview screen.

Prepare: This menu contains several sub options for preparing your printer prior to printing

Control: This menu as well as its sub-options allows the user to control aspects of their printer such as temperature, motion and firmware changes (if enabled). 
Card Menu: The last option allows you to browse and load any saved .gcode files if an SD card is inserted. 
Each of these menus contains a sub-menu with several options as well. Below is a brief review of the sub menus.

Prepare:

Disable Steppers: This will disable the motors and allow the user to move each axis by hand. 

AutoHome: This will home all axis to their starting points of 0,0,0.

Preheat PLA: This option will pre-heat the extruder to the specified temperature for PLA

Preheat ABS: This option will pre-heat the extruder to the specified temperature for PLA

Cooldown: Cooldown will disable the heater for the extruder and enable the cooling fan. Handy for after completing a print. 

Move Axis: This menu option and sub options will allow the user to move each axis’ as well as the extruder, a set distance. 

Control:

Temperature: The submenus under Temperature allow the user to define the default settings for extruder temperature, fan speeds, and other settings for both PLA and ABS. 

Motion: The motion menu contains the variables used in defining how the printer behaves during movements. This includes options such as acceleration values, jerk settings and retract/extrude values.

Store Memory: This option allows the user to save any changes they have made in any of the previous or sub menus. 

Load Memory: This option allows the user to load the configuration that is stored in the EEPROM of the printer. 

Restore Failsafe: The last option will reset the printer’s configuration to the default values that were flashed to the firmware. 
Card Menu: Lastly, if one wishes to print directly from the SD card, a user would first save the .gcode file created in their slicing application. After copying the gcode from their PC to the SD card, the user can then load the SD card into the printer. Selecting this menu will display all gcode files present on the card, and selecting any of the gcode files will initiate the print. 



Your First Print

a. Understanding the Cura Interface

Now that we’ve finally configured our printer, we may begin the process of our first print. 
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The Cura interface, like discussed earlier is broken into 2 areas, the print settings, and the print stage.

 The print settings contain variables that can be user adjusted to modify the print quality, speed and other options. Please refer to the settings referenced earlier in the guide. The settings panel also contains additional tabs for more control over the print settings. 
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Under the advanced tab you may see additional options for controlling items such as the (1) extruder nozzle diameter,(2) filament retraction and retraction speed. Under the Quality heading, the user can adjust settings such as the initial layer thickness, and width. The Speed heading contains all the settings relating to the speed of the machine, including its movements between prints, outer speed and infill speed. Lastly the cooling options allow the user to define how the print is actively cooled with the Cooling fan. 

The print stage will display the build volume of your printer, as well as any models or objects that you place on the stage. Users an pan, rotate and zoom around the stage using their mouse. The stage also allows the user to see several views of their model, ranging from an X-ray view to individual layers of the printed model:
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b. Loading and slicing your first model

We’re now ready to slice our first model. With Cura open, click the folder icon in the upper left corner of the print stage.
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You should now be greeted by a file explorer window. From here select the model you wish to print. For our first print, it is advised that you begin with something simple and quick to print, such as the mapleMaker key fob. (Link here)
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Your model will be automatically sliced and processed once it is loaded. You are now ready to print! 

Any changes made to the slicing variables in the right hand window will automatically re-process the model and re-slice the output. 
Should you wish to save the gcode and print from the SD card, disconnect your printer from your PC and click the Save icon. Save the .gcode file to your SD card, and then insert it into your printer.  

c. Starting & completing a print

Once you’ve chosen and sliced your object, ensure that your printer is connected to your PC and that it is connected in Cura. Once ready, simply click the ‘Print with USB’ button in the upper left of the print stage to begin the printing process. Your printer will heat the extruder, and then home each axis. 
Once the extruder reaches its temperature, and all the axis’s are homed, the printer will begin to print its first layer. 

Check to ensure that the filament is feeding correctly, and that the first layer is adhering to the bed. Your first layer should be slightly “squished” and adhere to the blue painters tape. Notice in the image below how the first outside layers are slightly fatter than the rest?
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Congratulations! You’re now printing! Soon your first test piece will be finished, and you’ll be able to pull it off the bed! When it is done, use a small putty knife, or scraper to peel it off the bed. Be careful not to tear the tape, although you can reapply more, and should do so periodically. 



Quick Tips
Maintenance Notes: 
Like any machine, your printer will require some periodic maintenance to ensure that it operates correctly. 

· Clean your printer using a light cloth and ensure that the extruder, filament, and print bed are clear of dust or debris

· Check the frame components for loose hardware or worn out parts. If any parts need to be replaced, print a new part and replace the affected pieces.

· Keep the linear rods clean of all debris and periodically add a small amount of machine oil to them to keep them lubricated. Do not oil your hot end or extruder gear. 

· Check all connections and wiring for loose connections or broken wires. 

· When not using your printer for extended periods of time, store your filament in a cool dry location with as little moisture as possible. If possible store your filament with a small silica gel packet to absorb any present moisture. 
Hardware:

Sloppy corners and bad details: If you find your prints corners look more like circles, or that small details in your prints are missing or look less than ideal, check the tension of the belts on your X and Y axis. Sometimes, loose or sagging belts can cause loss of detail and accuracy.
Slipping Filament: Is your filament not extruding correctly, or consistently? Try increasing the compression on the extruder idler by tightening the 2 long screws. This will force the filament into the drive gear and hopefully resolve the slipping. However, if your extruder is working fine, but no plastic is coming out of the hot end, your hot end may be jammed and may require dis-assembly to clean and fix. 

Printer not communicating: If you find your printer is not cooperating with your PC, check to ensure that the serial driver is installed correctly. To do so, uninstall Cura and then re-run the Cura installer. The installer includes the required drivers and should fix any issues you are having. 

Prints not sticking to the bed: If you find that your prints are not sticking to the bed, check your first layer height. The first layer should go down nice and flat, and be a bit fatter than the other layers. If you see any wavy lines or a very very thin extrusion, then chances are your first layer is too high. After several prints you may also need to remove and re-apply fresh blue painters tape to your bed as well. 

Resources:

For more information, tips, and tricks on using your 3D printer, visit some of these awesome sources of information.

3D Printing Resources:

RepRap Wiki: http://reprap.org/
Thomas Sanladerer’s 3D Printing Guides: https://www.youtube.com/user/ThomasSanladerer/
E3D Online: http://e3d-online.com/
3D Model Repositories:

YouMagine: www.youmagine.com
GrabCAD: www.grabcad.com
Makerbot Thingiverse: www.thingiverse.com
3D Modeling Software:

Sketchup: http://www.sketchup.com/
Tinkercad: https://tinkercad.com/
Autodesk 123DCatch: http://www.123dapp.com/catch
Blender: http://www.blender.org/
Meshlab: http://meshlab.sourceforge.net/
Netfabb: http://www.netfabb.com/basic.php
